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Introduction

Steady is a computer program that provides a generalized model to represent wastewater treatment plants. The model
assumes steady-state conditions for the influents to a given plant and characterizes wastewater with the traditional
environmental engineering parameters (BOD5, TSS, VSS, TKN, and NH3-N). Any given plant is represented by a
combination of Reactors and Streams. Reactors are all the components of a plant where water is processed in some way
and include all the unit processes, influents, effluents, and flow mixing/splitting units. Streams represent the connections
between Reactors, and their purpose is to let the program determine the interactions among Reactors. Once a valid plant
layout has been created, Steady can calculate the plant-wide mass balance and the general dimensions of the unit processes
involved.

Steady calculates the mass balance through an iterative process. At each iteration, Steady calculates the outputs of each
reactor based on the inputs received from other reactors. The outputs of a reactor are the flow and concentrations at each
stream going out of the reactor. After one iteration, the outputs of a reactor are compared with the outputs from the
previous iteration, if the absolute difference between all the components of the output (flow, concentration of BOD5,
concentration of TSS, etc.) is less than a specified convergence criterion, then the reactor has converged. The mass balance
converges when all reactors in a plant have converged; iterations stop at that point.

In this version of Steady, the following Reactors have been implemented:

Influent. It represents a source of wastewater. The user can indicate the flow rate and characteristics of the
wastewater coming out of an Influent.

 
Effluent. It represents a discharge from the plant, such as a discharge to a body of water.

 
Primary Settling Tank.

 
Activated Sludge Model 1. It represents the simplified activated sludge model of Lawrence and McCarty [1970]
as presented in Metcalf & Eddy [1991].

 
Activated Sludge Model 2. It represents a more thorough activated sludge system that accounts for influent
suspended solids, as presented in the paper by Chudoba & Tucek [1985].

 
Activated Sludge Model 3. It represents a simplified nitrification activated sludge system based on the model
developed at Malcolm Pirnie, Inc., for its program MASBAL [1982].
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Dissolved Air Flotation Thickening

 
Sludge Gravity Thickening

 
Sludge Digestion

 
Sludge Dewatering

 
Stream Splitting

 
Stream Mixing

Details about each of these units are discussed in a later chapter.

Steady also provides a graphical user interface where the user can create a plant layout just by drawing a flow diagram. This
interface also provides dialog boxes to edit the parameters of each unit, and a menu and toolbar to access the program's
commands.

The following sections of this manual discuss the installation requirements and procedures, a step-by-step example of
creating and calculating a plant, details about the commands available in Steady, and a detailed discussion of each of the
reactors included in this version of the program.

Installation

System Requirements

Steady requires an IBM compatible PC running Microsoft Windows 95 or 98, with at least 16 MB of RAM and about 15
MB of free Hard Disk space. There are no minimum requirements for the processor, but performance is better on a
Pentium 233 MHz or superior. Since Steady is a Visual Basic application (version 6.0), the Visual Basic runtime libraries
must be installed (included in the installation package). To install the runtime libraries you must have write access to the
WINDOWS/SYSTEM directory of the computer where you will install the program, as well as write privileges for the
directory where Steady will be copied.

Installing Steady

Three files are required to install Steady:

Setup.exe
 

Setup.lst
 

Steady.CAB (or Steady1.CAB, Steady2.CAB and Steady3.CAB if Steady came in floppy disks)

If you obtained Steady on a compressed ZIP file, you will need first to decompress it using a utility such as WinZip or
StuffIt. Once you have located these three files, run Setup.exe, and the installation program will start. This program will
guide you through the installation process, prompting you for information such as the name of the directory where you
want to install the program (if different from the proposed default) and the group within the Start/Programs menu where
the command to load Steady will be included. Depending on the system files already in you computer, the setup program
may need to restart your computer to complete the installation.

If you accepted the defaults proposed by the Setup program, you can now run Steady by loading it from the
Start/Programs/Steady menu in your Windows Taskbar; otherwise, select it from the group where you decided to install it.
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Using Steady - A Quick Tutorial

This section will contain a step by step description of how to build a plant layout, calculate the mass balance, show the
calculations, save the layout to a file, and export the data to Excel.

This section contains a step-by-step guide to creating an activated sludge plant. To follow this exercise you need to have
Steady installed on your system. If you accepted the installation defaults, to start the program you will need to go to the
Taskbar (usually at the bottom of the screen), press the Start button, choose the Programs menu, then the Steady menu,
and finally the Steady command.

1. After starting the program, you will see the Steady introduction screen. Here are displayed the credits for the
program. Press the Continue button to finish loading the program. 
 

2. You are now presented with the Flow Diagram window of the program, where you will draw the plant layout. The
first unit you are going to enter is a wastewater Source. Take the mouse pointer close to the top-left corner of the
drawing area and click the right mouse button. This will display the Units Menu. Select the first item; Source. The

mouse cursor will change shape to  , indicating that you are now in Unit Positioning mode. The coordinates of
the tip of the arrow will determine the location of the top-left corner of the Source. To select a location, click the
left mouse button. This will cause the icon of the Source unit to be drawn on the screen, which should look similar
to Figure 1.

Figure 1 - Source Unit Location

3. Next, change the parameters of this wastewater source. Move the mouse pointer towards the Source icon until it
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takes the Reactor Edit shape;  . Once the cursor has this shape, click on the right mouse button. This will
display the Reactor Edit menu. Select Edit Parameters. This will display the source's dialog box, where you can
change the default values of its parameters, shown in Figure 2.

Figure 2 - Default Source Parameters

4. Change the average flow to 20 MGD. First, press the à button to activate the MGD text box, then erase 10 and
enter 20. If you now press the ¬ button, the value in the L/s text box will be updated to 876.2, but this step is not
essential. Next change the Total BOD5 to 250 mg/L, and the Total Suspended Solids to 300 mg/L. Leave the rest
of the parameters as they are. To close the dialog box press the OK button. 
 

5. Now let's add a Primary Settling Tank. Again, over a blank area, click the right mouse button. Then select
Solids/Liquid Separation and then Primary Settling Tank. Move the cursor to the right of the Source and click
the left mouse button. This will add the settling tank to the diagram. 
 

6. Next add an activated sludge system. Select Biological Treatment/ Activated Sludge Mod. 1. Place the unit to the
right of the primary settling tank. 
 

7. Add an Effluent to the right of the activated sludge system. In this example we will use the default values for the
parameters of the units you just added. If you want, you can explore these values by clicking the right mouse button
over a unit's icon and selecting the Edit Parameters command. By now, your program window should look
something like Figure 3.
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Figure 3 - Location of Primary Settling Tank, Activated Sludge System and Effluent

8. Now connect the water treatment units. Move the cursor close to the arrow coming out from 1 - Source. When the

cursor changes shape to  , click the left mouse button. The cursor will change shape again, this time to a cross,
and a line will follow it as you move it. Take the cursor close to the arrow going into 2 - Primary Settling. When it
changes shape again, click the left mouse button. This operation creates the stream 3, which connects the outlet
from the source to the inlet to the primary settling tank. 
 

9. Next connect the overflow from the primary settling tank to the inlet to the aeration tank of the activated sludge
system, and the overflow from the secondary clarifier to the inlet of the effluent. Your diagram should now look like
Figure 4.
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Figure 4 - Connecting Reactors with Streams

10. Now, suppose that as part of the sludge treatment train, the plant will first thicken the secondary waste sludge using
a Dissolved Air Flotation (DAF) unit. Select Solids/Liquid Separation/Dissolved Air Flotation to add this unit.
As a preliminary location, place the DAF unit somewhere underneath the primary settling tank. 
 

11. Now add a mixing box to combine the primary and thickened secondary sludge. Select Stream Mixing and in the
dialog box that will appear select 2 In/Outlets, then click OK. Place the mixing box to the right of the DAF unit.
Your diagram should resemble Figure 5.
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Figure 5 - Initial Location of DAF Unit

12. To accommodate better the rest of the diagram, flip the DAF unit. To do this move the cursor over the DAF unit
icon and click the right mouse button, then select Change Flow Direction from the popup menu. 
 

13. Now move the unit to a location underneath the Activated Sludge system. First move the cursor over the DAF icon,
then press the left mouse button and move the mouse without releasing the button. When you release the button
the DAF icon will move to the new location. Your flow diagram should now look like Figure 6.
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Figure 6 - New DAF Location

14. Next, flip the Mixing Box so now the inlets come from the right and the outlet points to the left. 
 

15. Connect the sludge outlet from the Primary Settling Tank to the upper inlet of the Mixing Box and the thickened
secondary sludge (overflow from DAF unit) to the lower one. The flow diagram now looks like Figure 7.
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Figure 7 - Combining Primary and Thickened Secondary Sludge

16. Add a sludge digester (Sludge Treatment/Sludge Digestion) and a second effluent. Change the flow direction of
the digester and place it as shown in Figure 8. Move reactors as necessary. Connect the combined sludge from the
Mixing Box to the digester and the digester to the effluent. 
 

17. Now we want to recycle the underflow of the DAF unit to the head of the plant. First add a new mixing box with 2
inlets. Place it close to the primary settling tank. Then you have to delete stream 3. To do this move the mouse

cursor to any of the line segments that form stream 3. When the cursor changes to the   shape click the right
mouse button, then select Delete Stream.
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Figure 8 - Location of Digester

18. Now connect the underflow from the DAF unit to the lower inlet of the mixing box and the source to the upper
one. Then connect the outlet of the mixing box to the inlet of the primary settling tank. The plant layout is now
finished. It should look something like Figure 9.
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Figure 9 - Finished Plant Layout

19. This is a good time to save the file. From the File menu select Save and use the dialog box to select the name and
directory under which you want to save the file. 
 

20. Next, run the mass balance. Press the   button in the Toolbar. At the end of the iterations you will be asked if
you want to see the results, select Yes. The Mass Balance Summary window will then display the properties of each
stream in the layout, as shown in Figure 10.
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Figure 10 - Mass Balance Summary

21. By default the properties of each stream are shown in L/s and mg/L. You can view them as either m3/d and
kg/d or as MGD and lb/d by clicking on the option button next to each set of units. You can also change the size
of the window by dragging any of its edges, and you can use the horizontal and vertical scroll bars to view more of
the summary table. 
 

22. After calculating the mass balance the label in the box titled MB Current will say Yes in green, meaning that the
mass balance displayed in the window is current, or in other words, that the mass balance reflects all current
parameters of the plant. If you change any of the parameters of the plant, like the flow coming out of a source, the
label will change to No in red. When the mass balance is current you can click on the Show Calcs. button to display
the calculations performed at each unit process. 
 

23. You are now ready to print. In the File menu select Print FD & MB to print the flow diagram and the mass
balance summary. In the Print dialog box verify that the correct printer is selected and press OK. In the next dialog
box, Print Options, select both the Flow Diagram and Mass Balance check boxes, type in the title you want to
appear on the top of the page, select the Same page output format, and press the OK button. 
 

24. Instead of printing the calculations, export them to Microsoft Excel. Go to the File menu and select Export
Tables. In the Save As dialog box enter the name and directory where you want to save the file. Export files are
saved as comma delimited text files. Make sure that the file name you use here is not the same as the name under
which you saved the layout because you could overwrite it and lose the data. Now open Excel, go to the File menu
and select Open. In the field Files of Type: of the Open dialog box select Text Files (*.prn; *.txt; *.csv). Next
look for the Steady export file and press the Open button. In the Text Import Wizard - Step 1 of 3 dialog box
select Delimited under the Original Data Type options and then press the Next button. In the Text Import
Wizard - Step 2 of 3 dialog box select the Comma checkbox and make sure that the Text Qualifier is " (quotation
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marks), then press Finish button. You should now have the information in Excel, ready for further manipulation
and formatting. 
 

25. To increase the readability of the information in Excel, change the column widths, giving columns A and C greater
widths. Also, you might find the ' character (apostrophe) preceding all formulas in column C. This character is
required to let Excel now that the formula should be read as text, and not as a real Excel formula. To hide this
character go to Edit, select Replace, type ' in both the what and with fields, and press the Replace All button.
With this, Excel will re-interpret the ' character and will be hidden from the display. 
 

26. This is the end of the exercise. We have reviewed how to add unit processes, how to connect them with streams,
how to edit their parameters, how to move them, how to calculate the mass balance, how to print, and how to export
data. To exit the program select Exit from the File menu.

Commands and User Interface

There are three main ways to interact with Steady. The first is through menu commands, the second is through buttons on
the Toolbar, and the third is through mouse actions on the graphical user interface. This section explains the options
available for each of these interacting modes.

Menu Commands

Steady has two types of menus, the main menu on the program window and context sensitive popup menus. The main
menu is displayed along the top of the program window, whereas the popup menus appear anywhere on the drawing area
when the right mouse button is pressed. The popup menus are said to be context sensitive because a different menu
appears depending on the location or object where the right mouse button is pressed. Basically, there are three popup
menus. One is for adding reactors to the flow diagram, another is to make changes to existing reactors, and the third is to
make changes to existing streams.

Main Menu

The commands available in the main menu are described below:

File
New. This command clears the current plant layout to start a new one. If the plant layout was not saved
before selecting this command, all changes will be lost.

Open. This command opens previously saved plant layouts. It presents a dialog box where the user can select
the directory and file to open. If a plant layout is in the program already, it will be cleared and replaced by the
newly opened layout. Changes will be lost if the current layout is not saved before opening a new one.

Save. This command saves the current layout to the previously specified file name. If a file name has not been
defined when this command is invoked, a dialog box will prompt the user for a directory and file name. The
default extension of saved Steady files is .sdy.

Save As. Similar to Save, but this command always prompts for the directory and file name where to save the
current layout.

Print FD & MB. This command allows the user to print the Flow Diagram, the Mass Balance, or both.
When invoked, the command first displays the Print dialog box, as shown in Figure 11, where the printer can
be selected. Pressing the Properties button, it is possible to change the defaults of the printer, such as the
orientation of the pages (i.e., Portrait vs. Landscape).
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Figure 11 - Print Dialog Box

To continue with the printing process, the OK button is pressed once the printer and its default
properties have been selected. This will bring up the Print Options dialog box, shown in Figure
12, where some formatting options can be selected. By default the program only selects Flow
Diagram for printing, so the user must check the Mass Balance checkbox to print the mass
balance too. However, the Mass Balance checkbox will be grayed out (i.e., unavailable) if the mass
balance has not been calculated or is not current at the time the print command is invoked. Other
printing options include printing the file name at the bottom and a title at the top of the page.
The file name is printed when the checkbox next to the Printout Title text box is selected. The
Printout Title text box is available to place a title centered in the top of the page. If no title is
desired, the contents of this box should be cleared and left blank. Finally, at the bottom of the
dialog box is an option for printing the flow diagram and the mass balance on the same page or
on separate pages. The scale at which the diagram and table are printed is automatically adjusted
according to this option.
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Figure 12 - Print Options Dialog Box

Print Calculations. This command is used to print the table of calculations for the current
layout. It is only available if the mass balance has been calculated and is current. This command
uses the default system printer, which can be selected with the Print FD & MB command; the
printer defaults cannot be changed. This command always prints in Portrait orientation because
fewer pages are required in this way. After selecting this command from the menu, the Print
Calculations dialog box, shown in Figure 13, is displayed to provide options for printing the file
name and a title.

Figure 13 - Print Calculations Dialog Box

Export Tables. This command saves the contents of the Design Summary and the Mass Balance
Summary tables to a text file. This information is saved as a comma delimited text file, which can be
opened in most spreadsheet and database programs, as described in the tutorial. Export tables have a
.txt extension. The mass balance must be calculated and current at the time this command is called. A
dialog box prompts the user for a file name. By default the proposed name is the same as the file where
the layout is saved (including the extension .sdy), if any, and care must be taken with the file extensions
to avoid overwriting the layout with the tables.

Exit. This command closes all windows and exits the program. If changes to the layout had not been
saved previously, they will be lost.

View
Toolbar. Displays/hides the Toolbar, where some of the menu commands are available through buttons.
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Status Bar. Displays/hides the Status Bar, where information about the zoom factor, coordinates, and current
reactor are displayed.

Refresh. Causes the flow diagram to be redrawn, so that the screen is cleaned of "debris" left while editing the
flow diagram.

Zoom.

1/2 x. Causes the flow diagram to be drawn at half the current scale.

3/4 x. Causes the flow diagram to be drawn at three-quarters the current scale.

Normal. Causes the flow diagram to be drawn at the default scale.

1 1/4 x. Causes the flow diagram to be drawn at one and a quarter the current scale.

2 x. Causes the flow diagram to be drawn at double the current scale.

Tools
Add Reactor. This command invokes the Add Reactor popup menu, so the user can select the next reactor to
add to the flow diagram. Each reactor is described in detail in the next section of the manual, but the list of
reactors available is:

Source 
Effluent 
Solids/Liquid Separation

Primary Settling Tank 
Gravity Thickener 
Dissolved Air Flotation

Biological Treatment

Activated Sludge Mod. 1 
Activated Sludge Mod. 2 
Activated Sludge Mod. 3 - Nitrification

Sludge Treatment

Sludge Digestion 
Sludge Dewatering

Stream Mixing 
Stream Splitting

Calculate Processes and Mass Balance. This commands starts the calculations of the mass balance
and process design (where applicable). The mass balance can only be calculated when all inlets and
outlets of all reactors are properly connected, otherwise the program will indicate which inlets/outlets
still need to be connected. This command will start the iterations of the mass balance, which will
continue until the mass balance has converged or until the maximum number of iterations has been
reached. If the mass balance converges, the program can then display the Mass Balance Summary and
the Design Summary tables.

Options. This command calls up the Options dialog box, shown in Figure 14, where the default
options of the program can be entered. Here, the maximum number of iterations for the mass balance can
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be entered. If this number of iterations has been reached before the mass balance converges, the
iterations stop and the user is advised either to increase the number of allowed iterations or to loosen
the convergence criterion. The criterion for convergence represents the allowable absolute difference between
the flows and concentrations of one iteration and the next to consider them equal. In other words, when
the results (each flow and concentration) of one iteration and the results of the next iteration, for all
reactors, have an absolute difference equal to or smaller than the criterion for convergence, then the
program will stop iterating. The Peak Flow Factor represents the magnitude of the expected peak flow
expressed as a multiple of the average flow. The peak flow is used in some reactors to make sure that
the calculated design meets both average and peak flow criteria. Finally, the last option that can be
changed in this dialog box is the Font type. By pressing the Change Font button it is possible to select a
different font type and size. This font type is applied to all text in the flow diagram, but not in the
tables.

Figure 14 - Options Dialog Box

Window
Cascade. This command arranges all open child windows in cascade style.

Tile Horizontal. This command arranges all open child windows using the available parent window width
and dividing the height among the number of child windows.

Tile Vertical. With this command child windows are arranged side by side, occupying all available height.

Arrange Icons. When child windows are minimized and shown as icons, this command aligns the icons in
the lower-left corner of the main window.

List of Windows. The list of open windows is displayed in this section of the menu, and selecting any of the
items on this list causes the respective window to come to the front of the application.
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Help
Contents. This command calls up the table of contents of the program's help file.

About. This command shows the About form, where credits and information about Steady are presented.

Popup Menus

Add Reactor

This menu can be invoked by pressing the right mouse button anywhere in a blank area of the flow diagram drawing area.
Its purpose is to let the user select the next unit process to add to the flow diagram. The unit processes available are listed
in the previous section, under Tools/Add Reactor.

Reactor Edit

This menu can be invoked by pressing the right mouse button inside the area of influence of a reactor. The cursor changes
shape when it is inside the area of influence of a reactor. All commands in this menu affect only the reactor over which the
mouse button is pressed. The commands available in this menu are:

Edit Parameters. This command calls the dialog box where the operation and performance parameters of a reactor
are entered. Each reactor, when created, has default values for all its parameters. Invoking this command can change
these values. The particular parameters of each reactor are discussed in the next section of the manual.

Change Flow Direction. This command changes the direction in which a reactor is drawn. By default all reactors
are drawn so that water flows from left to right. If the reactor has streams connected to it, the position of the
streams is also changed to accommodate the new direction.

Edit Graphic Properties. This command is used to change the name of reactors. By default the program assigns
one number and one name to each reactor. Reactors of the same type will have the same name but different number.
Reactors are numbered sequentially in the order they are added to the flow diagram. Using this command calls up
the Reactor Name dialog box, shown in Figure 15, where the name and number of the reactor can be changed.

Figure 15 - Reactor Name Dialog Box

Delete Reactor. This command erases the selected reactor from the flow diagram, as well as any streams connected
to it.

Stream Edit

This menu can be invoked by pressing the right mouse button inside the area of influence of a stream. As with reactors, the
cursor will change shape when it is inside the area of influence of a stream. The commands available in this menu are:

Delete Stream. This command deletes the selected stream from the flow diagram.

Edit Properties. This command brings up the Stream Options dialog box, shown in Figure 16, where the
appearance and name of the selected stream can be customized. When streams are created they are numbered
sequentially in the order in which they are created. By default the sequential number is assigned as the ID code of
the stream. The ID code is used in the flow diagram to identify each stream, and it can be changed to anything the
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user wants by editing the ID Code field of the dialog box. Also by default each stream is assigned a name; this name
is related to the outlet from which the stream is coming. This name is used in the Mass Balance Summary table to
help identify streams more easily. The stream name can be changed in the Stream Name field of the dialog box.
Finally, each stream is also assigned a default color, line width, and line style that are related to the outlet to which
the stream is connected. These parameters can be changed in the Graphics section of the dialog box. Line widths are
measured in pixels. Only solid lines can have a width greater than 1 pixel.

Figure 16 - Stream Options Dialog Box

Toolbar

The Toolbar has buttons that provide shortcuts to access menu commands. Figure 17 shows the Toolbar included in Steady.
All commands are available through the menus except for Calculate Cost, which is a feature that has not been implemented
in Steady yet. The first four button, New, Open, Save, and Print, are commands of the File menu. Add Reactor and
Calculate Mass Balance are commands of the Tools menu. Zoom + and Zoom - are commands of the View menu. To use
any of these commands, just click the left mouse button over the corresponding button.

Figure 17 - Toolbar Commands
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Graphic User Interface

Some functions of the program are only accessible through the use of a mouse. One is the manipulation of windows
within the application, which is done the same way as in any other Windows program. Another is access to popup menus,
which as described, can be invoked by pressing the right mouse button over a blank area, over a reactor, or over a stream.
The popup menus are discussed above. The last function is moving reactors within the drawing area. As presented in the
tutorial, this is accomplished by taking the cursor over a reactor's area of influence, pressing the left mouse button, moving
the mouse without releasing the button, and releasing the button when the mouse is in the desired new position. All
streams connected to a reactor will update their paths to accommodate the new location of the reactor.

Unit Processes

A description of the parameters and underlying model of each unit process is provided in this section. The actual
calculations performed in each unit can be reviewed by printing the calculations of a completed plant layout that includes
the unit in question.

Source

This reactor represents a source of wastewater. It does not perform any processing beyond providing water of certain
characteristics. The flow and characterization of the wastewater can be customized. The icon of this reactor is presented in
Figure 18.

Figure 18 - Source Icon

Parameters

Table 1 presents the parameters of the Source reactor, and Figure 19 shows the dialog box where these parameters can be
edited.

Table 1 - Source Parameters

Parameter Description Default Value Units

Q Flow rate 438.00  L/s

TBOD5 Total BOD5 220.00  mg/L

SBOD5 Soluble BOD5 (expressed as a percent of Total
BOD5)

66.00  mg/L

TSS Total Suspended Solids 220.00  mg/L

VSS Volatile Suspended Solids (expressed as percent of
TSS)

176.00  mg/L

TKN Total Kjeldahl Nitrogen 40.00  mg/L

NH3-N Ammonia as Nitrogen 25.00  mg/L
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Figure 19 - Source Parameters Dialog Box

Remarks

Throughout Steady, for simplicity sake, the difference between TKN and NH3-N is assumed to be organic nitrogen in
particulate form. In this way, when calculating how wastewater constituents are handled in reactors that do not transform
reduced nitrogen, the mass of NH3-N, being soluble, follows the distribution of flow, whereas the mass of particulate
organic nitrogen follows the distribution of TSS. Then, at each outlet, TKN is calculated as the sum of the corresponding
mass of NH3-N and particulate organic nitrogen.

Effluent

The Effluent reactor serves as a sink for a stream of wastewater and is intended to represent an outlet from a plant, such as
a discharge to a water body or sludge disposal. This reactor does not have any parameters. Its icon is presented in Figure
20.

Figure 20 - Effluent Icon

 

Solids/Liquid Separation

Primary Settling Tank



Part 1 - Academic Report

file:///C|/Users/kinneyka/Documents/CE 364/Kinney Course/Steady Manual/SteadyManual.htm[2/21/2012 8:31:49 AM]

This reactor is intended to represent either a circular or rectangular gravity primary sedimentation basin. Its icon is shown
in Figure 21. This reactor performs three types of calculations. The first one is related to the performance of the settling
process, which has an effect on the overall plant mass balance. The second sizes the basins based on some user-specified
design parameters. The third checks that the calculated dimensions fall within user-specified design limits.

Figure 21 - Primary Settling Tank Icon

Parameters

Table 2 shows the list of process and design parameters of the primary settling tank. Table 3 shows the design criteria used
to validate the calculated unit dimensions.

Table 2 - Primary Settling Tank Parameters

Parameter Description Default Value Units

Process Parameters

TSS Removal  Percent of influent TSS captured in the settled sludge 60.00 %

TBOD Removal  Percent of influent TBOD5 captured in the settled
sludge

30.00 %

Sludge Concentration Assumed concentration of the settled sludge 50,000.00 mg/L

Design Parameters

Number of Units Number of tanks that the icon represents (needed to
size the tanks)

1  

Overflow rate Design overflow rate (at average flow) 40.00 m3/m2-d

Side Water Depth Side water depth 4.00 m

Tank Geometry Either circular or rectangular Circular  

Distance of Weir from
Basin Wall

Distance from the interior side of the basin wall to
the overflow weir (for circular tanks only)

0.75 m

Length/Width Ratio Ratio of the length to the width of the basin
(rectangular tanks only)

4.00  

 
Table 3 - Primary Settling Tank Design Criteria
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Parameter Default Value Units

Maximum Detention Time (@Qav) 2.50  hr 

Minimum Detention Time (@Qav) 1.50  hr

Minimum Detention Time (@Qpeak) 0.50  hr

Maximum Overflow Rate (@Qav) 50.00  m3/m2-d

Minimum Overflow Rate (@Qav) 30.00  m3/m2-d

Maximum Overflow Rate (@Qpeak) 120.00  m3/m2-d

Minimum Overflow Rate (@Qpeak) 80.00  m3/m2-d

Maximum allowable Diameter 60.00  m

Minimum allowable Diameter 3.00  m

Maximum allowable Length 100.00  m

Minimum allowable Length 10.00  m

Maximum allowable L/Depth ratio 25.00  -

Minimum allowable L/Depth ratio 4.20  -

Maximum allowable L/Width ratio 7.50  -

Minimum allowable L/Width ratio 1.00  -

Maximum allowable Side Water Depth 6.00  m

Minimum allowable Side Water Depth 3.00  m

Maximum allowable Width 24.00  m

Minimum allowable Width 3.00  m

Maximum allowable Weir Loading Rate 500.00  m3/m-d

Minimum allowable Weir Loading Rate 120.00  m3/m-d

Number of units 1.00  -

 

 Figures 24 to 26 show the corresponding dialog boxes where these parameters can be modified. 
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Figure 22 - Primary Settling Tank Process Parameters
 

Figure 23 - Primary Settling Tank Design Parameters
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Figure 24 - Primary Settling Tank Design Criteria

Process Modeling

The primary settling tank does not perform any mass transformations; rather, it solves the mass balance between the
influent and the two effluents: sludge and overflow. The user specifies the percentage of TSS and TBOD5, on a mass
basis, captured in the reactor. The sludge flow rate is then calculated using the specified sludge solids concentration. The
concentrations in the overflow are calculated based on the specified removal of influent TSS and TBOD5. The
concentrations of soluble components (SBOD5 and NH3-N) are passed unmodified to the outlet streams. In other words,
the mass of these constituents is distributed in proportion to the flow of each effluent. The particulate fraction of TKN
(i.e., difference between influent TKN and NH3-N) is distributed in the same proportion as TSS. If the specified removal
of TBOD5 is so large that the resulting effluent TBOD5 is smaller than the influent SBOD5, the model will adjust the
percent removal so that the effluent TBOD5 is at least equal to the influent SBOD5 concentration. When this happens, a
message box lets the user know that the TBOD5 percent removal was adjusted. The details of the calculations performed
by this reactor can be reviewed by printing the calculations of a completed plant layout.

Gravity Thickener

This reactor represents a sludge gravity thickener. The icon used in the program for this reactor is presented in Figure 25.
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Figure 25 - Gravity Thickener Icon

Parameters

Table 4 - Gravity Thickener Process Parameters
 

Parameter Default Value Units

TSS capture efficiency 90.00 %

Thickened sludge concentration 40,000.00 mg/L

 

Parameters of this unit process are shown below in Table 4, and Figure 26 shows the dialog box where the parameters are
entered. The routines to size and validate the dimensions with specified criteria have not been implemented for this reactor.

Process Modeling

This reactor is modeled so that the user specifies the percentage of solids capture and the expected sludge concentration
and the program calculates the sludge flow rate. Likewise, the program calculates VSS, particulate BOD5 and particulate
TKN assuming that they are distributed in the same proportion as the TSS. Soluble BOD5 and NH3-N are distributed in
proportion to the flow rates. 
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Figure 26 - Gravity Thickener Parameters

Dissolved Air Flotation

This reactor represents a solids-thickening unit based on dissolved air flotation. Its icon is presented below, in Figure 27.
In this unit, instead of having concentrated sludge in the bottom of the tank, the floated sludge is extracted as overflow
and the diluted water as a subnatant.

Figure 27 - DAF Unit Icon

Parameters

Parameters of this unit process are shown below in Table 5. The dialog box to change this parameters is identical to the
one presented in Figure 26. The routines to size and validate the dimensions with specified criteria are not implemented for
this reactor. 
 

Table 5 - DAF Process Parameters
 

Parameter Default Value Units

TSS capture efficiency 90.00 %
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Floated sludge concentration 40,000.00 Mg/L

 

Process Modeling

Like the gravity thickener, this reactor is modeled so that the user specifies the percentage of solids capture and the
expected sludge concentration, and the program calculates the sludge flow rate. Likewise, the program calculates VSS,
particulate BOD5 and particulate TKN assuming that they are distributed to each outlet in the same proportion as the TSS.
Soluble BOD5 and NH3-N are distributed in proportion to the flow rates.

Biological Treatment

Activated Sludge Mod. 1

This reactor represents a complete mix Activated Sludge system, including the aeration basin and the secondary
sedimentation tank. This model of the activated sludge process is based largely on the equations and assumptions
presented in: 
 

Metcalf & Eddy, Inc., "Wastewater Engineering. Treatment, Disposal, and Reuse." 3rd ed., McGraw-Hill, New York,
1991

Other assumptions required for calculating the mass balances are presented in the section that discusses the model in more
detail below. The icon used to represent this reactor is shown in Figure 28.

Figure 28 - Activated Sludge Mod. 1 Icon

Parameters

Table 6 presents the process parameters for this reactor. Three parameters control the way in which the model calculates its
results: Model, Control, and Recycle. Although these parameters are stored numerically inside the program, their values are
selected through option buttons in the reactor's dialog box (shown in Figure 29). The Model parameter indicates whether
the Food/Microorganism relationship and the Mean Cell Residence Time are used to calculate the MLSS concentration, or
if the Yield Coefficient and the Endogenous Decay Coefficient are used instead. The Control parameter indicates which
combination of two variables among V, X and MCRT are used to calculate the third one. The parameter Recycle indicates
which parameter among the flow (Qr) and the concentration (Xr) of the recycle sludge will be calculated based on the
other. Although all the parameters initially have the default values indicated below, these are overwritten either by the user
or by the program once the calculations start, according to the control variables selected. 
 

Table 6 - Activated Sludge Mod. 1 Process Parameters
Parameter Description Default Value Units

Y  Yield coefficient (VSS basis) 0.65  mg/mg

kd  Endogenous decay coefficient 0.05  1/d
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F/M  Food-to-microorganism ratio 0.30  1/d

MCRT  Mean Cell Residence time 8.00  days 

V  Volume of each aeration tank 15,000.00  m3 

X  Mixed Liquor Suspended Solids (Total) 3,000.00  mg/L 

mg BOD/mg VSS Ratio of BOD to VSS in sludge 0.50   
Model  Based on F/M and MCRT (model = 0), or

based on Y and kd (model = 1)
1.00   

Control  Fix MCRT and V and calculate X (control =
0), fix X and V and calculate MCRT (control =
1), or fix X and MCRT and calculate V
(control = 2)

2.00   

Recycle  Fix Xr and calculate Qr (recycle = 0), or fix Qr
and calculate Xr (recycle = 1)

0.00  

MLVSS/MLSS  Ratio of MLVSS/MLSS 0.75   
Qr  Recycle flow 200.00  L/s

Xr  TSS concentration in recycle 10,000.00  mg/L

TBODe  Effluent total BOD 20.00  mg/L 

TSSe  Effluent TSS 20.00  mg/L 
 

This reactor can calculate the general dimensions of the aeration tanks and secondary sedimentation basins based on the
design parameters shown in Table 7. The dialog box to enter these parameters is presented in Figure 30. This
implementation of the model, however, does not validate the calculated dimensions against specified design criteria. 
 

Table 7 - Activated Sludge Mod. 1 Design Parameters
Parameter Description Default Value Units

Num. Aeration Tanks  Number of aeration tanks in service 1.00  units 

Num. Clarifiers  Number of secondary clarifiers in service 1.00  units 

Side Water Depth  Aeration Tank Side Water Depth 6.00  m 

Side Water Depth  Clarifier Side Water Depth 3.50  m 

Length/Width Aeration Tank Length/Width Ratio 2.00   
Overflow Rate (@Qav) Clarifier Overflow Rate 25.00  m3/m2-d
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Figure 29 - Activated Sludge Mod. 1 Process Parameters Dialog Box
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Figure 30 - Activated Sludge Mod. 1 Design Parameters Dialog Box

Process Modeling

This model takes the characteristics of the influent stream and the specified effluent total BOD5 and calculates operational
parameters such as the MLSS concentration and sludge production. Calculations are based on BOD5 removal, which is
considered as the difference between influent total BOD5 and effluent soluble BOD5. The basis for this is the assumption
that all BOD5 that enters the system in particulate form is hydrolyzed in the aeration tank. The soluble BOD5 of the
effluent is calculated from the specified effluent total BOD5 and the BOD content of effluent TSS.

The excess sludge produced in the system is assumed to exit through the clarifier effluent and through the waste sludge
outlet. In the former, the specified effluent TSS gives the concentration, and in the latter the concentration is the same as
in the recycle sludge. The calculated mean cell residence time is based on the cell mass that leaves the system through these
two outlets. Soluble BOD5 has the same concentration in all outlets, and is calculated from the effluent TBOD5 and the
BOD5 content of TSS. No absorption or transformation of ammonia is assumed, so the concentration of NH3-N in all
streams is the same as in the influent. It is also assumed that nitrogen that is not in the form of ammonia is particulate and
that it is conservative and leaves the system in proportion to TSS, so TKN is calculated as the sum of the corresponding
NH3-N and particulate nitrogen concentrations at each outlet.

Activated Sludge Mod. 2

This model of the activated sludge process is also for a complete mix system, but it is based on the equations and
assumptions presented in:

Chudoba, J, and Tucek, F, "Production, Degradation, and Composition of Activated Sludge in Aeration Systems without
Primary Sedimentation." WPCF Journal, March 1985, p. 201-206.

This model, unlike the previous one and others, does account for influent suspended solids and for the non-biodegradable
part of influent SS and MLSS. This allows a more accurate estimation of sludge production in the system. Although the
model was developed with raw waters (i.e., without primary sedimentation) in mind, it has been shown to be applicable to
plants that have primary treatment. The icon to represent this process in the program is shown in Figure 31.
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Figure 31 - Activated Sludge Mod. 2 Icon

Parameters

The process parameters of this model are shown in Table 8, and the corresponding dialog box in Figure 32. Table 9
presents the list of design parameters of this model, which are the same as for the other models of activated sludge
included in the program. The respective dialog box is shown in Figure 30. 
 

Table 8 - Activated Sludge Mod. 2 Process Parameters
Parameter Description Default Value Units

Y  Yield coefficient (VSS based) 0.65  mg/mg

Kd  Endogenous decay coefficient 0.15  d-1

MCRT  Mean Cell Residence Time 8.00  days

V  Volume of each aeration tank 15,000.00  m3

X  Mixed Liquor Suspended Solids (Total) 3,000.00  mg/L

Control  Fix MCRT and V and calculate X (Control
= 0), or fix X and MCRT and calculate V
(Control = 1)

1.00  -

Recycle  Fix Xr and calculate Qr (Recycle = 0), or
fix Qr and calculate Xr (Recycle = 1)

0.00 -

Qr  Recycle flow 200.00  L/s

Xr  TSS concentration in recycle 10,000.00  mg/L

TBODe  Effluent total BOD 20.00  mg/L

TSSe  Effluent TSS 20.00  mg/L

fm  Mineral fraction of synthesized biomass 0.07  -

Beta  Fraction of organic biomass that is not
aerobically biodegradable

0.22  -

fo  Organic fraction of influent TSS Calculated internally
from the influent
VSS/TSS ratio 

-

Alpha  Fraction of organic influent TSS that is
not aerobically biodegradable

0.37  -

 

The Control and Recycle parameters are used in the same way as in Model 1. 
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Table 9 - Activated Sludge Mod. 2 Design Parameters
Parameter Description Default Value Units

Num. Aeration Tanks  Number of aeration tanks in service 1.00  units 

Num. Clarifiers  Number of secondary clarifiers in service 1.00  units 

Side Water Depth  Aeration Tank Side Water Depth 6.00  m 

Side Water Depth  Clarifier Side Water Depth 3.50  m 

Length/Width Aeration Tank Length/Width Ratio 2.00   
Overflow Rate (@Qav) Clarifier Overflow Rate 25.00  m3/m2-d

 

Figure 32 - Activated Sludge Mod. 2 Process Parameters Dialog Box

Process Modeling

In this model, BOD removal is based on total BOD5 for both influent and effluent. Soluble BOD5 at the effluent is
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calculated from the total BOD5 and the BOD content of effluent TSS. MLSS concentration and sludge production are
calculated in this model taking into account the effects of suspended solids in the influent. Besides these differences, the
rest of the variables are calculated using the same assumptions as in Model 1. The actual calculations can be reviewed by
printing the calculations of a completed plant layout that includes this reactor.

Activated Sludge Mod. 3 - Nitrification

This reactor incorporates a complete mix suspended growth nitrification model that can be used either as a single or as a
second stage system. When used as a second stage system, a bypass line coming from the primary settling tank might be
required to provide sufficient carbonaceous material to maintain the desired sludge residence time. Such a bypass can be
created using a Splitter Box reactor (discussed subsequently).

This reactor is the only one in Steady that has a model where TKN is actually consumed. The icon used in the program for
this reactor is shown in Figure 33.

Figure 33 - Activated Sludge Mod. 3 Icon

Parameters

The process parameters for this unit are presented in Table 10, and the corresponding dialog box is shown in Figure 34.
The design parameters for this unit are the same as for the other two models of activated sludge and are presented in Table
11. 
 

Table 10 - Activated Sludge Mod. 3 Process Parameters
Parameter Description Default Value Units

kd  Endogenous decay coefficient 0.05  1/d

Ys  Carbonaceous yield coefficient (mg VSS/mg BOD) 0.65  mg/mg

Yn  Nitrifiers yield coefficient (TKN is assumed to be
formed mainly by NH4, so units are
mgVSS/mgNH4)

0.20  mg/mg

MCRT  Mean Cell Residence time 8.00  days

V  Volume of each aeration tank 15,000.00  m3

X  Mixed Liquor Suspended Solids (Total) 3,000.00  mg/L

Qr  Recycle flow 200.00  L/s

Xr  TSS concentration in recycle 10,000.00  mg/L

mgBOD/mgVSS  Ratio of BOD to VSS in sludge 0.50  mg/mg

mgTKN/mgVSS  Content of TKN in VSS 0.04  mg/mg

TBODe  Effluent total BOD 20.00  mg/L
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TSSe  Effluent TSS 20.00  mg/L

TKNe  Required Nitrogen in effluent 5.00  mg/L

Control  Fix MCRT and V and calculate X (Control = 0), or
fix X and MCRT and calculate V (Control = 1)

1.00  -

Recycle  Fix Xr and calculate Qr (Recycle = 0), or fix Qr and
calculate Xr (Recycle = 1)

-  -

 
Table 11 - Activated Sludge Mod. 3 Design Parameters

Parameter Description Default Value Units

Num. Aeration Tanks  Number of aeration tanks in service 1.00  units 

Num. Clarifiers  Number of secondary clarifiers in service 1.00  units 

Side Water Depth  Aeration Tank Side Water Depth 6.00  m 

Side Water Depth  Clarifier Side Water Depth 3.50  m 

Length/Width Aeration Tank Length/Width Ratio 2.00   
Overflow Rate (@Qav) Clarifier Overflow Rate 25.00  m3/m2-d
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Figure 34 - Activated Sludge Mod. 3 Process Parameters Dialog Box

Process Modeling

With this model, the influent and effluent values of total BOD5 and TKN are used to calculate MLSS and sludge
production based on carbonaceous and nitrogenous yield coefficients and a lumped decay coefficient. It is assumed that
influent TSS decay at the same rate as biological solids synthesized in this unit. The reason is that it is assumed that
influent TSS are biological in nature because most come from a previous biological process (i.e., this model was originally
developed to simulate second stage nitrification).

When using this unit as a second stage nitrification system, care should be taken to make sure that the influent to the unit
has enough carbonaceous material to produce the specified MCRT. This can be achieved either with a bypass from the
primary settling tank or by specifying a high total BOD5 concentration at the effluent of the first stage system. The bypass
option is the safest choice for designing a plant because it is more flexible. When there is not enough total BOD5 at the
influent of this reactor, the specified MCRT cannot be achieved because not enough biomass can be synthesized. This will
be reflected by negative sludge flow rates in the mass balance summary. To fix this problem, increase the fraction of flow
coming from the bypass or specify a lower BOD removal in the first stage system. Details of the calculations performed in
this unit can be reviewed by printing the calculations of a completed plant that includes this unit process.
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Sludge Treatment

Sludge Digestion

This unit is modeled as a generic sludge digestion process that can represent either an anaerobic or an aerobic digester. The
icon for this reactor is shown below in Figure 35.

Figure 35 - Sludge Digestion Icon

Parameters

The process parameters of this unit are shown in Table 12, and the corresponding dialog box is presented in Figure 36.
Because of the general nature of this unit, it does not perform basin design calculations, and thus no design parameters are
associated with it. 
 

Table 12 - Sludge Digestion Process Parameters
Parameter Description Default Value Units

VSS/TSS Influent VSS/TSS ratio (if not calculated
from the influent)

0.75  mg/mg

VSS Reduction Portion of VSS destroyed 40.00  %

FSS Reduction Portion of NVSS destroyed 10.00  %

TBOD Reduction Portion of TBOD destroyed 40.00  %

SBODcreated/
VSSdestroyed

Soluble BOD produced per VSS destroyed 0.40  mg/mg

NH3created/
VSSdestroyed

Ammonia produced per VSS destroyed 0.04  mg/mg

 
 



Part 1 - Academic Report

file:///C|/Users/kinneyka/Documents/CE 364/Kinney Course/Steady Manual/SteadyManual.htm[2/21/2012 8:31:49 AM]

Figure 36 - Sludge Digestion Process Parameters Dialog Box

Process Modeling

The reduction of incoming VSS and FSS (or non-volatile SS) is calculated based on direct factors provided by the user.
BOD and NH3 solubilization is also calculated by direct factors. The ratio of influent VSS to TSS can be either calculated
from the influent properties or the user can specify it. Flow rate is maintained as it passes through the reactor. Although
ammonia is created from VSS, it is assumed that TKN does not change across the reactor because the created ammonia
had been already accounted for in the organic nitrogen of influent TKN.

Sludge Dewatering

This generic unit represents a typical sludge dewatering process, such as a belt filter press, centrifuge, or drying bed. In this
process, incoming sludge is concentrated to a high degree forming a cake for disposal. Likewise, the filtrate is available
from the other unit outlet for disposal or recycling in the plant. The icon that represents this unit in the program is shown
below in Figure 37.

Figure 37 - Sludge Dewatering Icon

Parameters

The process parameters of this unit are presented in Table 13, and the corresponding dialog box is shown in Figure 38. As
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in the case of the sludge digestion unit, this unit is also general in nature and basic design routines are not implemented. 
 

Table 13 - Sludge Dewatering Process Parameters
Parameter Description Default Value Units

Solids Capture  TSS capture efficiency 95.00  %

Cake Concentration  Dewatered sludge concentration 200,000.00  mg/L
 

Process Modeling

This reactor is modeled so that the user specifies the percentage of solids capture and the expected cake concentration; the
program then calculates the sludge and return flow rates. Likewise, the program calculates VSS, particulate BOD5 and
particulate TKN assuming that they are distributed in the same proportion as the TSS. Soluble BOD5 and NH3-N are
distributed in proportion to the flow rates. 
 

Figure 38 - Sludge Dewatering Process Parameters Dialog Box

Stream Mixing

This unit is used to combine several streams into one. The unit can have between two and ten inlets. Figure 39 shows the
icon for a mixing box of four inlets.
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Figure 39 - Mixing Box Icon

Parameters

This reactor does not have any process parameters.

Process Modeling

The characteristics of the effluent stream are calculated solving the mass balance for each wastewater constituent, so that
the mass coming in through all inlets is equal to the mass going out in the outlet.

Stream Splitting

This unit is used to divide a stream in two or more (up to ten) streams. A unit like this is used, for instance, to bypass a
fraction of the flow going into an activated sludge system so that it is later mixed with its effluent and then treated in a
second stage nitrification system and thus provide enough carbonaceous loading. Figure 40 shows the icon of a splitter box
with 6 outlets.

Figure 40 - Splitter Box Icon

Parameters

The only parameter of this unit is the fraction of the influent flow that is sent through each outlet. By default, this fraction
is the same for all outlets and the sum of the fractions is equal to 1. The user can change the distribution of the flow using
the dialog box shown in Figure 41. In this dialog box, the number of enabled text boxes corresponds to the number of
outlets the unit has. If the default fractions are changed, the sum of the new fractions must amount to 100%; otherwise,
the program will produce an error message. Outlet numbers correspond to the position of the outlet from top to bottom in
the reactor's icon. 
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Figure 41 - Splitter Box Process Parameters Dialog Box

Process Modeling

This unit by default distributes the influent flow between the number of outlets indicated when the unit was created. No
mass transformation occurs in this unit, so all effluents have the same concentrations (BOD, TSS, etc.) of the influent
stream. The distribution of flow needs not be equal for all outlets, but the sum of all flows must equal the influent flow.
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